Have a
Winning Season
10 Plays to Help You Reach Your 2013 Goals, page 10

10 Time-Saving Tips for the Appointment Book
page 18

Strategies for Improving Cash Flow from the
CEO of Million Dollar PPO
page 28

A Patient’s Perspective of Your Technology
page 30
www.Dentrix.com/Magazine
Dentrix Magazine Volume 25 Issue 1 — Spring 2013

moRe tRaining.
deepeR inSightS.
RicheR connectionS.
Choose from more than 70 training sessions taught by the
industry’s best and brightest. Maximize your dental technology
investments, improve productivity, boost profitability and
enhance patient care with more than 1,300 peers and colleagues.

Space iS Limited, RegiSteR today at

BusinessOfDentistry.com

M a R eg
Y1
5 th i st e R
&S
B
av Y
e$
30

0

Find the answers at the Business of Dentistry Conference
at the luxurious aria Resort and Casino in Las Vegas.
august 8-10, 2013

Editor:
Matt Singerman

New Year’s Resolutions
From the Editor
According to a study reported in the University of Scranton’s Journal
of Clinical Psychology (December 13, 2012), 45 percent of Americans
usually make New Year’s resolutions, but only 8 percent successfully
achieve them. (For a summary of the report, see www.statisticbrain.
com/new-years-resolution-statistics.) Are you surprised? Neither
am I. The truth is that keeping resolutions is hard; it requires lasting
commitment and a well prepared game plan.
Dental practice teams also need a game plan. In this issue of Dentrix
Magazine, Jim Philhower and Tammy McHood share ten plays you
can include in your playbook to help you reach your practice’s 2013
profitability goals. Their recommendations range from boosting the
production generated from hygiene visits, to updating your coding
and fees, to improvements in scheduling and collections. Read
their article, “Have A Winning Season” (pp. 10-14), for the full list
of recommendations.
Several other articles in this issue offer additional suggestions that
will help you improve your efficiency and profitability. In her article,
“10 Time Saving Tips for the Appointment Book” (pp. 18-22), May
Wescott shares Dentrix tips that will speed up scheduling processes
and increase the productivity of your front desk team. Dr. Matthew
Krieger, founder and CEO of Million Dollar PPO, offers strategies
to help you get paid faster and maintain your cash flow (pp. 28-29).
And, Jason Werner, a career marketing professional, shares thoughts
about using technology in your office to retain new patients after
your marketing has drawn them in (p. 30).
I hope you enjoy reading this issue of Dentrix Magazine. Please consult
the reading guide on page 2 to find the articles that correspond to
your responsibilities in the practice. And remember, every issue of
Dentrix Magazine is available online at www.dentrix.com/magazine.
Download yours today.
Regards,

Matt Singerman
Editor
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How To Learn More
If you want to learn more about the Dentrix topics featured in Dentrix Magazine, check out these self-paced learning resources.
Dentrix Help Files
In the Dentrix Help files, you can explore a comprehensive
list of conveniently indexed topics or search the topics for key
words. To search the Help files, from the Help menu in any
Dentrix Module, click Contents, click the Search tab, type a
search phrase or topic name, click List Topics, and then under
Select Topic, double-click the topic name. Tip: To turn off the
search highlights, press F5.
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Dentrix Resource Center
The Dentrix Resource Center offers an online library
of on-demand software training videos, downloadable
product manuals, and a knowledgebase of technical support
articles. Access is free for dental practices on a Dentrix
Customer Service Plan. Log in today at www.dentrix.com/
resource-center.

Get Dentrix News, Tips
and Information
Sent Right to Your Inbox.

The Dentrix eNewsletter will help you stay up to date
on the latest Dentrix product information, education
opportunities, industry news, tips and tricks,
promotional offers and more!
Once a month you’ll receive an eNewsletter
featuring the following content:

PRODUCT INFORMATION
TRAINING AND SUPPORT
PARTNER PRODUCTS
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SIGN UP TODAY AT
WWW.DENTRIX.COM/NEWSLETTER
and don’t miss out on the most up-to-date Dentrix information!
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www.Twitter.com/Dentrix
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Dentrix News
Practice Safeguard, eDossea, and Weave Now Available
in the Dentrix MarketPlace

Now available in the Dentrix Marketplace, Practice
Safeguard™ is financial monitoring software developed by
dentists and certified fraud examiners. It’s a web-based tool
that helps deter fraud by monitoring extreme and unusual
transactions in your practice data. Practice Safeguard alerts
you instantly to potential issues so that you can resolve violations and protect your income.
eDossea’s cloud-based solution for secure, efficient, and
painless record sharing between dentists and specialists is now
available in the Dentrix MarketPlace as a Dentrix Connected

Partner. With eDossea, dental care providers can use webbased technology to transfer digital patient data (such as
X-rays) between practices in a HIPAA-compliant environment.
As a Dentrix compatible product, Weave helps office staff
personalize patient phone calls by automatically displaying
basic family information from the Dentrix database whenever
a patient calls your practice. Before the call is even answered,
an alert appears showing the caller’s family information, lists
any upcoming birthdays, and indicates if there are scheduled
appointments for the family or appointments that need to
be scheduled.
Dentrix Marketplace continues to be a one-stop solution
for dental offices seeking to extend the power of Dentrix by
adding fully integrated applications and capabilities to their
practice management platform. To see what other technologies are available, visit Dentrix MarketPlace at www.dentrixmarketplace.com.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their
company, products and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions
and consumers should contact these providers directly if seeking additional information about their products or services.

Henry Schein Partners with Dr. Charles Blair for Webinar
on 2013 CDT Codes

Henry Schein recently had the exciting opportunity to
partner with Dr. Charles Blair, a nationally recognized expert
on dental coding, to present a webinar entitled “The Future of
Dentistry and Expert Coding Advice.” In the webinar, Dr. Blair
discussed the new 2013 CDT codes, which codes offices should
be using, and how they affect the way offices bill insurance. He
also gave suggestions about how to use codes and claim narratives to maximize insurance reimbursements.
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The live webinar was free to anyone who registered to
participate. A recording of the webinar is currently available
in the Dentrix Resource Center to all offices with a current
customer service plan. To view the webinar recording, log in
to the Dentrix Resource center at www.dentrix.com/resourcecenter. Click the On-Demand Training tab, click Profitability
topics, and then click the title of the webinar, “The Future of
Dentistry and Expert Coding Advice.”
Henry Schein regularly offers webinars on a variety of
Dentrix and eServices topics. Some webinars are freely available
to any participants, and some are reserved for Dentrix Customer
Service Plan subscribers. All of the webinars are recorded, and
the webinar recordings are available for on-demand viewing in
the Dentrix Resource Center. Visit www.dentrix.com/webinars
today to see a schedule of upcoming webinars and to register
for a webinar. Or, log in to www.dentrix.com/resource-center
and click the On-Demand Training tab to view recordings of
previous webinars.

New Insurance Carrier Connections

On January 31, 2013 many new electronic connections were
established for insurance claims, attachments, explanation of
benefits, and eligibility verifications.

Automated and on-demand electronic eligibility verifications
can now be received from the following payors:

Payor ID	Payor Name
16117		RMSCO

Electronic claims can now be sent through Dentrix to the
following payors:

53011		 National Association of Letter Carriers/ NALC

Payor ID	Payor Name

55204		 Health Now NY

CBID2		 Regence Blue Shield of Idaho
81883		 Arkansas Municipal Health Benefit Fund
KYCS1		 Caresource KY
74385		Insurance Systems Inc.
93200		 Regence Blue Cross Blue Shield of Washington
CAPHP		 Caprock Health Plans
CB850		 Regence Blue Cross Blue Shield of Oregon
CBID2		 Regence Blue Shield of Idaho
HGL01		 Heavy & General Laborers
TLX61		 ASEA/ AFSCME Local 52
00580		 CareFirst Inc. BCBS of Maryland
TPC08		 Hawaii- Western Management Group (HWMG)
TPC11		 South Carolina Healthy Connections

Digital attachments can now be added to electronic claims
submitted to the following payors:

Payor ID	Payor Name

TLU43		 Regence Blue Cross Blue Shield of UT
CKAZ1		Medicaid of Arizona
CBIA2		 Blue Cross Blue Shield of Iowa (Wellmark)
00580		 CareFirst Inc. BCBS of Maryland

54763		 AmeriHealth Administrators
57604		 Aetna Affordable Health Choices (SM)-SRC
CBC01		 Capital Blue Cross (CBC)/ Blue Cross Dental (MD)
CDOK1		Delta Dental of Oklahoma
CKWA1		Medicaid of Washington
CX061		 Lincoln Financial Group
CX076		 Administrative Services Only (ASO)
CX088		 Surency Life and Health
CX043		EBS Benefit Solutions
HMSA1		 (HMSA) Hawaii Medical Services-Commercial
TLU51		 Central OA Teamsters Health & Welfare Fund
TLW33 		 Western PA Teamsters Fund
TLX23		 National Automatic Sprinkler Industry
TLX24		 Health Benefit Claims Dept.
TLX61		 ASEA/ AFSCME Local 52
WT017		 Unum Dental Plan
The entire list of electronic payor connections is available
at http://www.dentrix.com/products/eservices/eclaims/payorsearch.aspx. You can search for specific payors or download the
complete payor list.
For more information on these new payors or any of the
services listed above, contact eServices Customer Support at
800-734-5561.

eEOBs can now be received for electronic claims submitted
to the following payor:

Payor ID	Payor Name

5LX049		 Prime West Health
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Tips

&Tricks
The tips in this section describe valuable but easily overlooked Dentrix features that
simplify workflow and increase efficiency. Find the tips that correspond to your role
in the practice and try them out today. Start making your job easier and your practice
more profitable.

Access Appointments from
the Treatment Planner
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Did you know you can access
patient appointments from the
Treatment Planner? This makes
scheduling chair-side appointments easy! In the Treatment
Planner, from the Options menu,
click Other Appointments. This
opens the Appointment Book as
well as the Family Appointment
List dialog box. From this dialog
box you can select a family
member and see each person’s
past and future appointments, as
well as procedures included in
treatment plans. Click the Create
New Appointment button and
fill in the necessary information to
schedule an appointment for the
selected family member.

Co
lle
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Contact Patients Using
the Collections Manager
If you need to identify patients
with past-due balances based
on account aging, insurance
claim status, or last payment
date, use the Collections
Manager. You can also use
the Collections Manager to
generate collections letters,
send email messages, or set
up a payment agreement.
For more information, see
the Collections Management
webinar recording in the
Dentrix Resource Center.

Generating the Day Sheet Report by
Entry Date or Procedure Date
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Did you know you that in addition to generating
a Day Sheet Report based on a date range, you
can specify if you want the report to reflect either
the Entry Date or Procedure Date? While the
entry date and procedure date for a transaction
are usually the same, if a procedure was backdated the dates will differ, so there may be times
when you want to specify which date you want
the report to use. For more information, see
the Generating Key Reports tutorial in the
Dentrix Resource Center.
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Reduce Rejected Claims

Insurance billing experts say that a short
explanation of why treatment was performed can
make all the difference when insurance carriers
are considering whether or not to cover a procedure. You can add these notes in the Remarks
for Unusual Services box on the insurance claim.
Remember to keep notes short and simple. Only
include information that supports the treatment
decision. For more information, see the Dentrix
eNewsletter article titled Reducing Claim Denials
with Claim Remarks at www.dentrix.com/articles/
content.aspx?id=301.
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View Future Family Appointments
on the Family Walkout Statement

s

The Family Walkout Statement is a printed record
of the treatment the family had done that day, including
the charges and the patient/family balances. It can also
show all of the family’s future appointment dates. This
can save time and money by not having to write all that
information on separate appointment cards.

Updating Scheduled Production
It’s the start of a new year! It may be a good time
to look at the fees you are charging for procedures.
Once you have updated your office fee schedule,
you can use the Update Scheduled Amounts on
Appointments feature to update the fees in your
scheduled appointments without having to edit
appointments individually. The Update Scheduled
Amount on Appointments feature lets you select
a starting date for the updated fees to take effect.
The Update Scheduled Amounts for Appointments
feature works with Dentrix G4 Productivity Pack 7 or
higher. To access this feature, from the Appointment
Book click Options > Update Scheduled Amounts.
For more information about updating scheduled
amounts or updating your office fee schedule, see
articles #47709 and #34608, respectively, in the
Dentrix Resource Center knowledgebase.

Use PowerPay to Collect Recurring Payments

Bi

lli

ng

&

A/

R

Sc
he

du

lin

g

Are you using PowerPay to collect payments from patients
on a payment agreement? Then why not set up recurring charges (called consents) so a patient’s credit card
is automatically billed at designated intervals. For more
information see article #59818 in the Dentrix Resource
Center knowledgebase.
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How much time do you spend every week preparing,
printing, assembling and mailing patient statements?
Get all the control of manually produced patient billing statements
without all the tedious busywork or expensive inventory. With just a
few clicks in Dentrix, you can send billing statements to the patients
of your choice.
Save time—By eliminating all your statement-related busywork
Save money—By allowing you to get rid of expensive supply inventories
Look more professional—By sending polished, customized statements
Stay in control—By specifying how, when and where statements get sent

Enroll today and get your first
month of statements 50% off!

1-800-734-5561

Contact us today and learn how to eliminate the
busywork and boost your practice efficiency.
©2013 Henry Schein, Inc. A-ESQBDTXMAG-Q113
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H av e a

Winning
Season
Jim Philhower, Director of Dental Leadership & Development
Tammy McHood, Senior Product Manager

10 Plays to Help You Reach Your 2013 Goals
How often do our long-term goals take a back seat to our more immediate needs?
On a daily basis we prioritize urgent over important as emergency patients take time
from scheduled appointments, and an unexpected twist in a procedure causes a ripple
delay throughout the day. While this can never be completely avoided, prioritizing the
big picture is critical to reaching your goals. When the final two teams meet in the NCAA
Championship, do you think they start preparing the night before? Cramming on game
tapes and research, putting together last-minute plays? Not if they expect to win. The
best teams have done their research well in advance and created plays tailor-made for
this game. They know the strengths and weaknesses of every player and have planned,
prepared, and practiced to win this game. You can do the same by approaching your
2013 goals with the same level of dedication and preparation.
Dentists face many business challenges as they set their practice goals for 2013. The
number one concern for dentists today is not enough new patients. Offices are also seeing
fewer patient visits and fewer patients with dental benefits. We also see an increase in
managed care (PPO participation). Eighty percent of all insurance plans sold last year were
PPOs. The result is a declining reimbursement rate leading to less cash flow, higher overhead, and increased stress for dentists as business owners. Dentists will need to increase
their focus on internal marketing and brand differentiation to attract new patients and
combat these new managed care challenges.
The good news is many of the answers to these challenges can be found in your practice today. Here are 10 “plays” you can include in your game plan to help you reach your
practice goals for 2013.
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1

Active Hygiene
Patient Analysis

One of your focuses
should be your hygiene
department. Approximately 25-40
percent of all practice production
should be coming from your hygiene
department, and 75-80 percent of
doctor production should originate
from hygiene visits. Yet in too many
cases just 50 percent of active patients

new patient referrals also. We’ll discuss
that in a moment.

2

Perio Review

The next step in your
hygiene analysis could
be a closer look at the
percentage of periodontal procedures
your office is currently performing.
According to the AAP and ADA, 75-80
percent of the adult population has

Figure 1 The Continuing Care section of the Practice Advisor Report.
are currently in the practice’s continuing
care program. If hygiene visits are not
what they should be, implement a Total
Health educational program to improve
your continuing care statistics. This type
of oral/systemic information motivates
patients not just to maintain regular
dental visits but also to accept recommended treatment. To learn more
about the Total Health program go
to www.totalhealthlearning.com.
The Dentrix Practice Advisor Report
can show you how many active patients
have been in your hygiene department
in the last 12 months. To run this report,
from the Analysis menu in the Office
Manager, click Practice Advisor. Click
Practice Advisor Report. In the Practice
Advisor Report dialog box, select
the dentists, hygienists, and desired
options for your report. Make sure you
select Continuing Care and All under
Select CC Types. Click Preview. When
the report is finished generating, the
Patients with CC Visit within last 12
months statistics on page 3 of the
report will let you know how many (and
what percentage) of your patients have
had a continuing care hygiene visit in
the last 12 months (Figure 1).
A highly effective hygiene department will be one of your best sources of
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some form of periodontal disease. And
when asked, most doctors feel that
15-25 percent of their patient base
should be in their periodontal therapy
program. Yet when we look at the
Practice Analysis Report, we typically
find that just 3-5 percent of patients
are in perio therapy. In most cases the
offices are performing the procedures

Figure 2 The Production Summary Report.

but are not getting paid for the work
because of improper coding and billing
of procedures.
You can review your perio procedures as you perform a full code review,
as explained in the next tip.

3

Coding Review

A regular review of your
coding procedures will
ensure that you maximize
insurance reimbursement for your
patients while increasing your profitability. It can also reveal any areas of
coding that could get you into trouble.
While you must use the appropriate
code for the work you do, there are many
coding revisions, additions, and deletions every year. The insurance companies are not going to call your office to
let you know that you could have billed
and been reimbursed for a procedure or
if you used an outdated code that they
no longer pay for. A thorough review of
the coding used for the most frequently
performed procedures in your office
could prove beneficial.
The Production Summary Report
will help you see which procedures you
are actually using (Figure 2). To run this
report, in the Office Manager, from
the Analysis menu, click Practice. Click
Reports from the menu bar to display
the Practice Analysis Reports dialog
box. Under Select Summary Reports,
select Production Summary and by

Proc Code Range. Click Print to print
the report or Batch to send the report
to the Batch Processor.

4

New Patient Referrals

Your best source of
new patients is your active
patient base. Start by
identifying your top 20 percent “ideal”
patients: they show up on time, accept
your treatment plans, pay their bills, and
refer their family and friends.
Run the Daily Huddle Report to help
you identify these patients. In the Office
Manager, from the Analysis menu, click

To track referrals, from the Office
Manager’s Maintenance menu, point
to Reference, and then click Referral
Maintenance. Use the Referral
Maintenance dialog box (Figure 3) to
add new referrals and manage your
referral information.

5

Implementing a
Health Checklist

After an initial health
history, how often are
your patients asked for updates on
their overall health? Most offices rely on

Figure 3 The Referral Maintenance dialog box.

Practice Advisor. Click Daily Huddle
Report. Select the details and options
you want to include, such as Production,
Collections, and Case Acceptance, and
then click Preview.
In your morning huddle, select two
of these patients and determine who
will ask for the referral. You will find that
these patients have friends and family
members much like them who could
become new patients of yours. Make
sure you set new patient goals for 2013,
and then put in place the metrics to
track and measure your results.
Dentrix allows you to track referrals
so you can review them in the Practice
Advisor Report (mentioned earlier) on
a monthly basis. The Practice Advisor
Report helps you see not only how
many new patients you have added but
also where the referrals are coming from
and how many new patients are being
referred by your existing patients.

patients to volunteer changes in health,
but most patients are not aware of how
these changes can or will affect their
dental visit. You can use a simple total
health checklist during each hygiene
visit to ask patients about their overall
health, nutrition, sleep habits, and
more. This information not only keeps
the team up to date on health changes,
it also uncovers potential treatment
needs and provides an opportunity to
educate patients about the value of the
dental appointment.
The checklist can also assist you
in building referral relationships with
physicians as you uncover medical
needs that have not been addressed.
Finally, it can help you differentiate your
practice with a health focus, elevating
your practice in the minds of patients.
To view a sample health checklist,
visit www.henryscheindental.com/
healthchecklist.

6

Radiography Review

7

Increase Case
Acceptance

8

Optimize Scheduling

Determine how many
patients have not received
the radiographs they are
due for. Put procedures in place to ensure
that going forward all radiographs needed
are taken. This is critical to operating a
minimally-invasive practice—radiographs
provide opportunities for early intervention and can reduce the number of invasive
procedures needed in the long run.
Tracking key continuing care types
such as Pano/FMX is critical as patients
come into your practice. This ensures
that your team knows who is due for
these major X-rays. If one major X-ray
is missed a day, this can add up to a
$20,000 loss in production every year.

Place dental problems
in the context of total
health for patients so they will properly
prioritize treatment. Use the Dentrix
Treatment Planner to track case presentation and status, so the team can
follow up. Most offices have an intraoral
camera, but very few use it regularly.
Using an intraoral camera on every
patient and documenting the findings
can increase production 25 percent.
Use the Treatment Manager to generate
a list of patients with existing treatment
plans who meet certain criteria. Then
devise a game plan for contacting these
patients and achieving acceptance.
For more information on using the
Treatment Planner and the Treatment
Manager, see those sections of the
Dentrix Help.

The Treatment
Manager can also help
you optimize scheduling
by helping you find patients with
existing high-production treatment
plans and benefits remaining. Perfect
Day Scheduling is another tool you can
use to optimize your scheduling. It can
help you set aside high production
periods of the day or week for highproduction appointments you identify
using the Treatment Manager.
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From the Options menu in the
Appointment Book, click Perfect Day
Scheduling to display each provider’s
time blocks. To move a time block
within its respective operatory, drag
the time block to the time you want. To
increase or decrease the time block’s
size, drag the bottom border of the
time block down to increase or up to
decrease the block’s size.

9

Improving
Collections

Managing collections
and insurance payments
is a major challenge for any dental
practice. There are several tools within
Dentrix that can help you reduce bad
debt, identify problem accounts, and
streamline your insurance management,
patient billing and payment, production,
and collections processes. Some of
these tools include the Citi Health Card,
PowerPay, QuickBill, and the Dentrix
Collections Manager.
For information on the Citi Health
Card, go to www.dentrix.com/products/
technology-partners/citi%20health. For
information on PowerPay and QuickBill,
go to www.dentrix.com/products/
eservices/default.aspx.
To use the Dentrix Collections
Manager, in the Office Manager,
from the Analysis menu, click
Collections Manager. In the
Collections Manager View dialog
box, set the criteria that you want
to use for creating a collections list
and click OK. The collections list
appears in the Dentrix Collections
Manager window (Figure 4).

your immediate geographic area for the
most accurate comparison. (When you
have a Henry Schein Practice Analysis
performed, this is part of the analysis.)
When you’re ready to change your fee
schedule, in the Office Manager, from
the Maintenance menu, point to Practice
Setup, and then click Auto Fee Schedule
Changes. You can select Change Fee
Schedule and increase all your fees by a
certain percent or dollar amount, or you
can select Copy Fee Schedule To and
create a new custom fee schedule. When
you are finished, click Change.
If your practice hasn’t had a fee
schedule analysis in a while, Henry
Schein Dental Practice Analysis can
help you review your fee schedules and
compare them to other practices in
your specific ZIP Code. To learn more,
go to www.henryscheindental.com/
PracticeAnalysisRequest.
This can be a daunting list for
many practices as they struggle with
how to access and track much of the
information above. However, as a
Dentrix user, all of the data you need
can be quickly and easily extracted
from your software. For help organizing
and reviewing the information, your
Henry Schein representative can input
the data into a Practice Analysis. This

Balance Fees
Fees should be
analyzed annually.
While you may not
be comfortable with an overall fee
increase at this time, there’s a good
chance at least a few of your fees
fall outside the positioning you’ve
created for your practice. Select
a percentile for your fees and
increase or decrease those that fall
outside your selected range. Make
sure your fee comparison uses just
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Figure 4 The Dentrix Collections Manager.

analysis can help you easily identify
the areas to target in your 2013 plan
for hygiene, perio, exams, radiographs,
and patient flow. To learn more
about practice analysis, go to
www.henryschein.com/us-en/sites/
wedothat/practiceanalysis.html.
After the initial analysis review, many
offices need help monitoring these
practice statistics and others to ensure
that any corrective steps are working
effectively. A Dentrix profitability coach
can tailor a program to help you and
your team members incorporate best
practices into your daily routines. With
coaching and monitoring to keep your
plan on track, you’ll be on your way
to meeting your 2013 goals. Visit
www.dentrix.com/profitabilitycoaching
for more information.
LEARN MORE
To request a Henry Schein Dental
Practice Analysis for your practice,
go to www.henryscheindental.com/
PracticeAnalysisRequest or ask your
Henry Schein Dental field sales consultant
for one today. To learn how Profitability
Coaching can help your practice implement more best practices while using
the valuable tools in Dentrix, go to
www.dentrix.com/profitabilitycoaching.

Get Expert Advice with
a Personal Touch

Let our experts show you how to put all the features of Dentrix to work for
your practice, and help you identify the reports and performance metrics you
should focus on to gain greater profitability.
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• Improve coding accuracies

• Give more accurate patient estimates

• Keep patients coming back

• Get timely insurance payments
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• Keep your schedules filled
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• Go paperless
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Or Call 866.609.5510
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Senior Editor

Take advantage of these 10 time-saving
Appointment Book tips to help you keep
your day rolling along.

T

he other day I was on my way to a meeting.
Luck wasn’t with me, and I had to stop at
every stoplight along the way. At the last
stoplight, some road construction made it
necessary to take an alternate route. The combination of the red lights and the detour made me
20 minutes late.
On my way home, I found a new route with
half the number of stoplights and no detours.
This shortcut has been saving me time ever since.
During your busy work day you may have
similar experiences. You plan your day to be
productive and to take advantage of every hour,
but along the way you encounter delays and
detours that rob you of huge chunks of time.
This article provides some tips to speed up
processes and help you avoid some unnecessary
delays. These Appointment Book shortcuts are
easy to set up and use. Over time, they can make
a big difference in your overall productivity.

Information May Be Closer than It Appears
One avoidable delay can be the need to stop
what you’re doing to run a report or look up
some information. Wouldn’t it be nice to display
that information where you can view it
at a glance? The first three tips will show you
how you can set up the Appointment Book to
access important information quickly and easily
(Figure 1).
1 – View Daily Estimated Production Amounts
If you’re working in an office that is scheduling for production, you need to know how
you’re doing in meeting your daily scheduling
goals. Dentrix has some great reports to show
you detailed information about the ins and outs
of scheduled production. But most of the time
you may just want to see at a glance if you’re
hitting your scheduling goals for the day.

The number shown here
is the estimated total
production scheduled
for the day. There is
$4,220.00 scheduled
for the day.

The number shown
here is the estimated
total production for
this appointment. This
appointment should
generate $749 in
production.

By setting the Appt
Reason as consecutive
line items in the View
setup, the reason will
wrap to a sceond line.

Figure 1 By setting your View options, you can see important production information at a glance.
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Dentrix makes it easy. By checking
one box in the View setup, you can see
your estimated production totals for
each day right from the Appointment
Book. From the View menu in the
Appointment Book, select the first
view you have set up and click Edit.

2 – View Amounts on Appointments
If you want to see at a glance the
estimated production amount for an
individual appointment, you can do
that in View setup too. From the View
menu, select the first view you have set
up, and click Edit. In the Select View

These Appointment Book shortcuts are easy
to set up and use. Over time, they can make
a big difference in your overall productivity.

In the Select View dialog box select
View Amount. Click OK to save your
changes. (Repeat this process for any
other views where you’d like to see total
production amounts.)
When you return to the Appointment
Book, you’ll notice that Dentrix now
shows a number above the Time Bar on
the right side of your book. That’s the
amount of estimated scheduled production for the day.
Note: Dentrix adds a 0 in front of the
amount so it’s not as easy for patients to
recognize it as a dollar amount.
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dialog box you’ll see the Appointment
Display Info customization fields.
Choose which line you’d like to use to
view estimated production amounts
and then set the field for that line
to Amount. Click OK to save your
changes. Repeat this process for all
other views where you’d like to see
production amounts.
When you return to the Appointment
Book, you’ll see the estimated production amount for each appointment on
the line you indicated.

3 – Wrap the Text of an Appointment Reason to another Line
If displayed appointments appear
small because you’re viewing multiple
operatories or a patient has multiple

procedures attached to the visit, the
entire appointment reason won’t show
on the face of the appointment. You can
give yourself some more room to see
those reasons by wrapping the appointment reason to the next line. To set this
view up, from the View menu, select
the first view you have set up and click
Edit. In the Select View dialog box,
you’ll see the Appointment Display
Info fields. Set up your Line fields so
that the Appt Reason field uses two
consecutive lines. For example, if Appt
Reason is currently Line 2, change
Line 3 to also be Appt Reason. The
fields must be in consecutive order for
the wrap function to work.
Remember that all three of these
view settings can be turned on or off
with the different views that you set up.
As a bonus tip, don’t forget that you can
switch between your views by pressing
the function keys (F1, F2, and so forth)
on your keyboard.

One Click is All It Takes
Detours can be especially frustrating. Sometimes when you’re in the
middle of scheduling a patient, you have
to detour from a scheduling task to look
up information in a patient’s Ledger
or Family File. These next tips will give
you some fast work-arounds to get you
speeding back on your way—with just
one click.
4 – View Medical Alerts and Appointment Notes with a Single Click
You’re looking at an appointment
that has a symbol on it indicating a
medical alert or an appointment note.
Do you want a quick way to see what’s
going on with that patient?
Click once on the symbol to
open a dialog box that shows
you any medical alerts for
the patient, the appointment
note, and anything entered
into the Patient Note (Family
File) and Guarantor Note
(Ledger) for the patient.
Note: You can also click on
other appointment symbols
including patient alerts, insurance eligibility, and lab cases
to see related information.

When you break an appointment
in the Appointment Book, the
date of the appointment is recorded here. The number indicates the
number of times the patient has
broken appointment.

Figure 2 Missed appointment data is shown in the Family File.

5 – View Account Information
In the middle of scheduling Brent
Crosby’s appointment, he asks you if
his wife has a hygiene appointment
scheduled soon, if you’ve received his
last payment, and if you have his correct
phone number. Wouldn’t it be nice if
you could look up the answers to those
questions without having to exit out of
the appointment you’re scheduling?
If you’ve already started entering
the information in the Appointment
Information dialog box, just click
the More Info button. The More
Information dialog box appears
and gives you summary information
about family members, appointments,
continuing care, balance information,
and personal information.
You can switch between members
of the family by clicking a name in the
Family list. After you select another
name, all the information in the dialog
box updates to reflect the information
for the patient you just selected.
You can switch to the Ledger with
the patient already selected by clicking
Ledger at the bottom of the dialog box.
The Ledger opens without you having to
exit out of your appointment.
Best of all, when you close the More
Information dialog box, you return to
the Appointment Information dialog
box, with all the information you’ve
entered still in place.
6 – Keep Track of the Number
of Missed Appointments
John Walker calls and cancels…
again. You know he’s done this several

times before, but you’re not quite sure
how many times it’s happened. Don’t
worry, Dentrix keeps track of this for
you. Every time you break an appointment for a patient by clicking the Break
Appointment button, Dentrix updates
the Missed Appointment counter in
the Family File and notes the date the
patient was originally scheduled. It
also adds an entry indicating a broken
appointment (including the appointment reason) to the Office Journal. A
single click updates all that information
automatically (Figure 2).
Note: If you want to move a patient
to the Unscheduled List without
counting it as a broken or missed
appointment, you can do so by
double-clicking the appointment.
From the Appointment Information
dialog box, click the Wait/Will Call
button to move the appointment to
the Unscheduled List.

Relief from Rescheduling Gridlock
One thing that can really cause a jam
in your day is getting cancellation calls.
Here are a couple of tips that can help.
7 – Drag and Drop Scheduling
from Lists
You’re making phone calls from the
Unscheduled List to fill some open time
in your Appointment Book. Wouldn’t
it be great if you could just drag the
patient from the list to an open appointment time? With G4 Dentrix PP7 and
later, you can—and not just from the
Unscheduled List. You can use this functionality from any of the lists accessed

from the Appt Lists menu, including
the ASAP List, the Pinboard List, and
the Appointment List. Just click on a
patient’s appointment while viewing a
list, and then drag the appointment to an
open time in your book (Figure 3). Presto,
the appointment has been moved off of
your list and rescheduled.

8 – Reschedule the Whole Family
Jan Simmons calls and lets you
know that the kids all have the stomach
flu and won’t be able to make their
appointments tomorrow. You appreciate
the warning, but rescheduling all five
of those appointments isn’t going to
be easy. Dentrix can make it easier by
helping you to move all those appointments to the Pinboard with just two
mouse clicks.
To move all family appointments for
a single day to the Pinboard, right-click
one of the family members’ appointments, point to Move to Pinboard, and
then click Family Appts for Displayed
Date. Dentrix grabs all of the appointments for anyone in the family scheduled on that day and moves them
to the Pinboard. The appointments
will stay on the Pinboard until you
reschedule them.
Note: You can use this same process
to move all the appointments for an
operatory, a provider, or the whole day.
9 – Purge Unscheduled Appointments
Your office has been using the
Break Appointment button correctly
for the last two years. After breaking
appointments, staff members make a
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Click and Drag

Figure 3 Click and drag appointments from Dentrix lists to open times in your Appointment Book.

good effort to get those appointments
rescheduled and off the Unscheduled
List, but there are some appointments
that just never get rescheduled. After
two years, those unscheduleable
appointments have added up—and are
cluttering up your list.
Fortunately, you can remove all
those old unscheduled appointments
by running a simple utility. From the
Unscheduled List menu, click Appt then
select Purge Appointments. Enter a
Cut Off Date. All unscheduled appointments dated before the cut off date will
be removed from the list.
Note: It’s probably a good idea to
establish a cut-off rule for your office.
For example, you might decide that the
cut-off date will always be one year out.

Customization to Grease the Wheels
When you first started using Dentrix,
your trainer probably walked you
through customizing a lot of the settings
for your Appointment Book. But time
may have changed some of your needs

22 | www.Dentrix.com/Magazine

(or the ADA may have changed some
codes), and now those settings are no
longer helping you—they’re slowing you
down. Maybe it’s time to take a look at
some of those customizations and tune
them up a bit.

10 – Customize the List of Initial
Appointment Reasons
It’s been driving you crazy. Ever since
the ADA released their new code set,
your fluoride appointment reasons are all
wrong. Every time you have to schedule
an appointment with a fluoride treatment,
you have to either add code D1208 to the
patient’s treatment plan or go through
the long process of selecting the code
by clicking the Misc button. Fortunately,
this is easy to fix by customizing the list
of initial appointment reasons. Through
customization you can both remove
codes you don’t use (like expired ADA
codes) and add codes that you do use.
To customize the list of initial
appointment reasons, go to the Office
Manager. From the Maintenance

menu, point to Practice Setup,
and then click Definitions. From
the Definition Type list, select
Appointment Reasons. Add, edit, or
delete the listed reasons. Click OK
when you’re done making changes.
You’re still going to have days where
it feels like you’ve spent the last eight
hours stuck in traffic, but by using these
shortcuts you’ll feel like you’re in the
fast lane rather than gridlock.

LEARN MORE
To learn more about the Appointment
Book, see the Appointment Book section
of the Dentrix Help. You can also visit
the Dentrix Resource Center to view the
Appointment Book on-demand training
titles. See “How to Learn More” on page 2 for
instructions on accessing these resources.
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The Dentrix Office Manager
Discover These Dentrix Keyboard Shortcuts
Learn these time-saving keyboard shortcuts in Dentrix.

Dayna Johnson | Certified Dentrix Trainer

O

ne of the things I love about
Dentrix is that there are several
ways to accomplish the same
thing. For example, every Dentrix module
has a toolbar with icons you can click to
accomplish common tasks. If you prefer
menus, you can perform these same
tasks using the menu bar at the top of
each module. Many Dentrix tasks are also
available on shortcut menus that appear
when you right-click certain areas in the
Dentrix modules. What you may not know
is that Dentrix also provides a number of
time-saving keyboard shortcuts that give
you quick access to common tasks.
Keyboard shortcuts are a great
time saver for one simple reason: your
fingers spend much of their time on the
keyboard. With keyboard shortcuts,
there’s no reaching for the mouse,
moving the pointer, and clicking. You
simply press one or two keys that are
literally at your fingertips.
This article explores some of the
little-known keyboard shortcuts that you
can memorize and begin using today.

Office Manager Shortcuts
The Dentrix Office Manager offers
keyboard shortcuts that let you quickly
jump to the beginning or end of a
multi-page document in Print Preview.
Select a multi-page document in the
Batch Processor (such as a fee schedule)
and press Alt+F, and then I to display
the Print Preview window. Pressing
Shift+End takes you to the end of the
document; pressing Shift+Home takes
you to the beginning of the document.
Patient Chart Shortcuts
After selecting a patient in the
Patient Chart, you can print that patient’s
dental chart by pressing F3. Specify any
print options you want and click OK .
With Dentrix G5 and later, the Patient
Chart module has an enhanced Refresh
feature that reloads any changes made
to setup configuration, such as added or
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edited procedure codes, multi-codes,
provider information, medical crosscoding, and Clinical Note Templates. To
refresh these settings, simply press F5.

Appointment Book Shortcuts
The Dentrix Appointment Book
offers several keyboard shortcuts. For
starters, you can define up to 12 custom
Appointment Book views that are
automatically assigned to the function
keys F1 through F12. To do this, click View
on the menu bar, and then click New to
display the Select View dialog box. The
first custom view you create is automatically assigned to the F1 function key, the
second view you create is assigned to
F2, and so forth. With each custom view,
you can specify which providers, operatories, days, times, and appointment
details appear in the Appointment Book.
After your views are created, to change
between views, simply press the corresponding function key, F1 through F12.
Here’s another Appointment Book
keyboard shortcut. To quickly switch to
the Appointment Book Day View, press
Ctrl+D. To switch to the Appointment
Book Week View, press Ctrl+W.
Menu Bar Shortcuts
The Dentrix menus at the top of each
module provide easy access to most
software tasks. For the Dentrix tasks you
perform regularly, you may find that it’s
faster to access them from the keyboard
by pressing the Alt key while pressing the
underlined letter in the menu title (usually
the first letter), and then pressing the
underlined mnemonic letter in the menu
option. For example, from the Appointment
Book, to open the Family File, press Alt+F,
and then F again. To open the Ledger,
press Alt+F, and then L. To print the current
Appointment Book View, press Alt+F, V,
and then Enter. To create a Daily Huddle
Report, press Alt+F, H, and then Enter.
You can use the keyboard to access
menu items in the other Dentrix

modules also. For example, if you have
the Patient Chart open, press Alt+O,
and then O again to open the Perio
Chart; press Alt +O, and then T to open
Treatment Planner.

F2 Select Patient Shortcut
In the Family File, Patient Chart,
and Ledger modules, you can press F2
to quickly display the Select Patient
dialog box, where you can select a
patient from the Dentrix database. In
the Appointment Book, because F2 is
reserved for custom views, use Shift+F2
to display the Select Patient dialog box.
Help Shortcuts
In nearly all of the Dentrix modules,
pressing F1 displays the Help window
where you can find helpful information
on using Dentrix. With the Help window
selected, you can use the Up Arrow and
Down Arrow keys to scroll through the
Help books on the Contents tab. You
can also use the Right Arrow key to open
a Help book and the Left Arrow key to
close a Help book.
If you use the Search tab to search for
certain words in the Dentrix Help, those
keywords are highlighted in the Help
topics. To turn off the search highlights,
you can simply press F5. (You may want
to do this before you print a Help topic.)
To print a Help topic, you can use the
standard Windows keyboard shortcut
Ctrl+P.
Dayna Johnson, founder and principal
consultant of Rae Dental Management, helps
dental offices improve patient care, increase
collections and reduce staff headaches by
implementing efficient management systems.
With 18 years experience in the business
and technical side of dental offices, Dayna’s
passion for efficient systems is grounded in
both personal understanding and professional expertise. Dayna can be reached at
dayna@raedentalmanagement.com or visit
her website at www raedentalmanagement.com.
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From the Coach
Keep Communication Open with Two-Way Chat
Use the two-way chat feature to have a real-time text message conversation with a patient who has
questions or needs to reschedule.

Andrea Gallimore | Dentrix eServices Coach

B

rent Crosby is having one of those
days. He’s been running behind
schedule ever since he got up this
morning and he’s stuck in a meeting with
a client who won’t stop talking. Brent
is wondering how he’s going to get to
everything he has to do today when he
gets an automated text message from
your office reminding him of his hygiene
appointment this afternoon (Figure 1).
In the old days, Brent might just have
blown off that appointment. He doesn’t
have time to get there on schedule, and
he’s stuck in a meeting so he can’t call
your office and talk to someone about
it. But, with the
Communication
Manager’s two-way
chat feature, he
can deal with his
scheduling issue
without leaving his
meeting, allowing
him to give your
office plenty of
notice about his
scheduling issues
and allowing you to
make sure that he
gets rescheduled.
Figure 1 With
Text messaging
the two-way chat
is fast, convenient,
feature, patients
and nearly universal.
can reply to your
In fact, on average
automated text
people read and
message reminders respond to text
and carry on a
messages in less
conversation with
than one minute.
you through text.
This makes texting
an ideal method for
sending quick reminders to patients before
their appointments.
The Communication Manager takes it
one step further by allowing your team to
have a real-time text message conversation with a patient who has questions or
needs to reschedule. If you have enabled
the non-confirmation text message
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Figure 2 By clicking on the pop-up
alert, you launch a chat window which
allows you to answer patient’s questions
or concerns without a phone call.

Received tab. From there you can view
the text message received from the
patient by clicking the message text
highlighted in blue. In both cases, this
launches the chat window and allows
you to type a reply.
An important part of quality care is
the ability to respond promptly and efficiently to patient questions and needs.
An important part of keeping your practice operating in the black is making sure
patients remember their appointments
so you don’t have empty chairs. Now the
eCentral Communication Manager gives
the front-office an easy way to do both
with the two-way chat feature.
LEARN MORE
To learn more about the two-way chat
feature, see the What’s New in eCentral
3.1 topic in the eCentral help, visit
www.dentrix.com/communication, or visit the
Dentrix Resource Center to view the Sending
Text Message Appointment Reminders
article. See “How to Learn More” on page 2
for instructions on accessing these resources.

notification in eSync, when a patient
replies to a text-message appointment
reminder with any response other than
a confirmation, your front-office team
will see a message pop up on their
computer screens. A simple click on the
message allows them to reply
to the response and continue
the conversation in a new chat
window (Figure 2).
If you’ve stepped away
from your desk and missed
the pop-up window, you can
easily review any messages you
may have missed by viewing
them in your email inbox or
opening a Correspondence
Report (Figure 3) in eCentral.
To reply to a message you
missed, select the View Text
Message Reply link in the
email message and the chat
window opens and displays
the text message received. Or
Figure 3 If you miss a pop-up message, you can
to reply to the patient from
review the messages that have come in from the
the Correspondence Report,
Correspondence Report.
select the Text Message

Make It Personal.

Build your success — one personal connection at a time.
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Business of Dentistry
Using eClaims to Improve Cash Flow
Learn how submitting electronic claims and attachments can help you get paid
faster and maintain your cash flow.

Matthew Krieger, DMD | Founder and CEO, Million Dollar PPO

F

or all practices, keeping accounts
receivable (A/R) low is a fundamental part of running a profitable
business. In most practices, a significant
portion of the overhead for each procedure is realized at the time that the
production occurs. Rent, utilities, salaries,
taxes, and fees for perishable supplies
are typically due every month regardless
of when, and how much, production
occurs. Other expenses, like lab fees and
supplies, are usually incurred within 30
to 60 days of production. If fees are not
collected in a timely manner, there is a
strong likelihood that the overall cash flow
of the practice will be affected. Cash is
critical to a practice’s ability to operate
and to excel.
In order to have the cash you need
to run your business, you need to collect
as much money as possible as close as
possible to the time of service. When
you’re dealing with patients, create and
enforce a sound, written policy that
describes the cost of the procedure, the
anticipated insurance contribution, and
the patients’ out-of-pocket obligation. A
written agreement between the doctor
and the patient is an absolute necessity
that will allow for simplified, stress free
collection of the patient’s up-front, outof-pocket expense.
For those practices that participate
with insurance companies and/or accept
assignment of benefits, collection does
not stop at the patient. A portion of
the cost (sometimes more than 50%)
must then be collected from an insurance company. One of the fundamental
beliefs I incorporate in my Million Dollar
PPO Coaching/Consulting firm is “profitability through efficiency,” and there is
no more efficient way to collect money
from insurance companies than through
the effective use of electronic claims
and attachments.
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Figure 1 The Fast Checkout button
in the Ledger allows you to generate a
walkout statement and create and send
an insurance claim with one click.

can be submitted electronically with
electronic attachments. Traditional paper
claims for similar procedures can take
up to 8 weeks to be paid, while you can
expect payment time of less than 30
days when you send electronic claims
with attachments, such as digital X-rays
and intra-oral images. And Dentrix helps
improve the consistency and accuracy of
the submission process by reviewing the
claims for mistakes before sending them
to the insurance company electronically,
thereby reducing errors and the need for
re-submissions that would extend the
reimbursement timeline.
To add electronic attachments to a
claim, from an insurance claim, double
click the Claim Information block to
open the Insurance Claim Information
dialog box (Figure 2). In the Attachments
group box, indicate the number of

When you’re working with claims
that don’t requiring additional documentation, like hygiene visits or basic
restorative procedures, Dentrix allows
you to generate a walkout statement for
the patient, create an insurance claim,
and send that claim electronically with
one click of the Fast Checkout button
in the Ledger (Figure 1). While in the
past this claim would be printed, signed,
and mailed to an insurance company,
with Dentrix eClaims it can now be
submitted immediately. You can expect
reimbursement from
insurance companies
for hygiene visits and
basic restorative claims
that were submitted
electronically in less
than 14 days.
Sending electronic
claims is not limited to
just hygiene visits and
basic restorative procedures. Submitting
electronic attachments along with your
electronic claims can
allow for a more rapid
reimbursement from
insurance companies. Periodontal,
oral surgery, and
endodontic procedures, along with
Figure 2 In the Insurance Claim Information dialog box
major restorative
you can add important information to a claim, including
procedures such as
electronic attachments like radiographs and perio charts.
crowns and onlays,

at all on an X-ray. In
some cases, major
problems requiring
significant restorative
procedures only show
up as minor issues on
a radiograph. If given
the choice between
denying a claim that
includes extensive
and illustrative documentation submitted
digitally or denying
a paper claim with
unclear duplicated
copies of traditional
radiographs, an insurance company will
more likely deny the
claim with the unclear
documentation.
In my practice
Figure 3 You can attach files from the Document Center,
we send electronic
Perio Chart, and Dexis Image to your claim. With Dentrix
claims and claim
G5, you can also capture and attach an image of any file
attachments. We
on your computer.
have created a claim
submission checklist
for all restorative, periodontal, oral
radiographs, oral images, and other
surgery, and endodontic claims to ensure
attachments enclosed and click Include
that the following are sent with every
Attachments to open the Include
electronic claim:
Attachments dialog box (Figure 3). You
•	Dentrix electronic claim
can then attach files from the Document
•	DEXIS digital X-ray (pre- and
Center, Perio Chart, DEXIS Imaging
post-op)
Suite, or the hard drive on your omputer.
•	DEXcam intra-oral photos (pre-op,
With Dentrix G5, you can also use the
intra-op, and post-op)
Screen Capture tool to capture and
• Necessary periodontal charting
attach an image of anything being
imported from Dentrix Perio Chart
displayed on your computer.
• Narrative (can be pre-loaded
In addition to speeding up the reiminto the Office Manager by clicking
bursement timeline and improving the
accuracy of claim submissions, sending
Maintenance > Practice Setup >
electronic claim attachments can also
Custom Notes > Claim
decrease the chances that a claim will be
Remarks Setup)
As part of our claim submission
denied. Many times what we as clinicians see in the mouth cannot be seen
process we also generate an insurance

If fees are not collected in a timely manner,
there is a strong likelihood that the overall
cash flow of the practice will be affected.
Cash is critical to a practice’s ability to
operate and to excel.

aging report on the first day of every
month, which helps us easily track
our outstanding claims and insurance
dollars. To run the Insurance Aging
Report in Dentrix, from the Office
Manager click Reports > Ledger >
Insurance Aging Report.
Implementing and following this
streamlined, convenient system of
sending electronic claims and attachments has allowed my practice to
improve its cash flow and maintain an
A/R of less than 5% at 30 days. The time
that we save through such an efficient
process allows us to utilize our available cash for training, education, and
expansion. Our efforts can be focused
on improving our practice for the benefit
of our patients instead of chasing after
money just to pay our bills.
Dr. Matthew Krieger graduated from
New Jersey Dental School in 1998. He
launched his own practice in 2003 and built
it into a full-time practice in just one year.
Dr. Krieger has collected more than one
million dollars in each of the last five years
and has grown his practice by 30 percent
annually—all while working only in 3.5 days
per week, maintaining an overhead of 57
percent, and participating in PPO insurance
plans. Dr. Krieger is the founder and CEO
of Million Dollar PPO, a dental practice
management coaching and consulting firm.
He also lectures on practice management
and CAD/CAM dentistry. Dr. Krieger is an
active member of the ADA, AGD, AACD,
ACE, and the Crown Council and has
earned over six hundred hours of continuing
education. For more information about how
Million Dollar PPO Coaching and Consulting
can help your practice, visit their website at
www.milliondollarppo.com.

LEARN MORE
To learn more about sending electronic claims and claim attachments, visit
www.dentrix.com/products/eservices/eclaims.
To learn more about claim attachments, see
the Sending Claim Attachments Overview
topic in the Dentrix Help. You can also visit
the Dentrix Resource Center and view the
eClaims tutorial or download the Submitting
Insurance
Claims
and
Attachments
Electronically getting started guide. See
“How to Learn More” on page 2 for more
information about accessing these resources.
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TechNotes
A Patient’s Perspective of Your Technology
Take a look at the technology in your office and use these tips and suggestions to see
where new technology might benefit your practice.

Jason Werner | Marketing Manager, Henry Schein TechCentral

M

arketing your dental practice
is critical to attracting new
patients. Using technology in
your reception, waiting, and clinical areas
is equally important in keeping those new
clients once your marketing has drawn
them in. Today’s patients are more aware of
technology and expect an office to be hightech. Technology makes a difference in why
a patient selects one dentist over another.
Patients perceive a high-tech office as
providing a higher level of care—whether
it’s true or not. Does the technology in
each area of your practice, including the
waiting and check-in areas, accurately
reflect the service your patients receive?
Dr. John Jameson suggests you look at
your practice through the eyes of your
patients (www.jamesonmanagement.com).
Would you choose to be a patient of an
office that looks like yours?

That Picture is Beautiful
Many practices invest heavily in treatment area technology while neglecting to
update technology in the reception area.
Your treatment area is a state-of-the-art
facility providing exceptional patient care,
but its effect can be dampened if your
patients’ first view of your practice is a
timeworn reception area. Your patients,
for example, will appreciate high-definition television with engaging content and
digital programming.
In addition, modern computer and
phone systems make a great impression at check-in. A computer running
multiple monitors makes workers more
productive. For example, your scheduling
coordinator will be more effective by
processing patients on one computer
monitor while continuously checking
appointments on another.
Your Printing Should Be Crisp
Don’t underestimate the value of the
printed page, even as you go paperless. A
patient treatment plan printed on bright
white 28-pound paper using a color laser
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printer has the advantage of crisper,
higher-quality print, while having a lower
price per page than traditional inkjet
devices. Replacing your aging printers with
a networked color laser printer lets your
patients walk away with proof that you have
a modern practice. For under $800, you and
your patients will be amazed by the quality
of X-rays and photo prints you produce,
and your team will be more productive due
to the increased printing speed.

A Lean, Green, Paperless Machine
A key initiative for modern practices
is shifting to paperless processes. Going
paperless not only helps define your
practice as modern, but it also improves
the efficiency of check-in and scheduling.
The latest page scanners are now small
enough to sit in front of a keyboard at
each office workstation. This reduces
logjams at shared units and allows staff
to scan documents, insurance cards, and
driver’s licenses directly into a patient’s
file without leaving their desk or waiting in
line behind a coworker.
Is Your Operating System a Teenager?
Windows XP was launched nearly
12 years ago. Tech-savvy patients can
tell if you are using outdated computer
systems—but more importantly, so
can your software and digital dental
technology. Take advantage during your
next PC refresh to move to more current
Microsoft operating systems, such as
Windows 7. Now that Windows 8 has
released, you may have wondered about
upgrading to the latest Windows version.
Before you do, consider that there are
practical advantages that come along with
Windows 7 as well. Taskbar pinning, Aero
display, and Shake are all great Windows 7
features that can make work easier. On the
other hand, if you’re an early technology
adopter looking to run Dentrix on Windows
8, Henry Schein will soon be releasing
a hotfix to Dentrix G5 that supports
Windows 8. Before you upgrade your

operating system, make sure that all your
hardware and software are compatible with
Windows 8, including third-party software
(such as imaging software) that you link to
through Dentrix. For the latest information
on Dentrix and eServices compatibility
with Windows 8, go to www.dentrix.com/
support/software-updates/g5.aspx.
Take advantage of Henry Schein
TechCentral computer experts to update
your practice to modern computers and
equipment. It will ultimately save you money
in productivity and cost less than upgrading
individual components in your office PCs.

Fuzzy Pictures and Dirty Mice
Many practices computerized their
treatment areas years ago. Walk into your
operatory and ask yourself, “Does my
technology promote a modern image
of my practice?” Television displays
have undergone improvements that put
them on par with computer monitors.
Razor-thin LED TVs with 1080p and HDMI
input provide super-bright, crystal-clear
images, whether showing broadcast
content, patient education or a computer
display. Take a look at other equipment—
a yellow, aged keyboard or mouse is a
good indication that it’s time to upgrade
to new, durable input devices that are
designed to handle disinfectants and that
are waterproof enough to run through a
dishwasher.
Stand Apart and Get Ahead
Set your practice apart with modern,
high-productivity technology solutions.
A 36- or 48-month equipment lease
allows you to budget for your investment
in technology while helping maintain
new equipment on a regular upgrade
cycle. You will appreciate how simple
upgrades to your office technology can
dramatically affect how patients perceive
your office. Contact Henry Schein
TechCentral at 877-483-0382 for professional assistance on every step of your
technological journey.

Office Technology to Power
Your Digital Practice

All-in-One PCs with
modern, touchscreen
displays

Network security
solutions to protect
your practice

High speed, reliable
networking and
installation

Secure, fast Wi-Fi
for your business
and patients

Ask how Henry Schein TechCentral solutions
can power your digital practice with a reliable
network, computers and expert support.

Call 877.483.0382

www.HenryScheinTechCentral.com
Available exclusively from

©2013 Henry Schein Inc. Third-party products, logos, trademarks or registered trademarks are the property of their respective owners. A-TCDTXM-Q113

solution spotlight

Demandforce and Dentrix:

Practice Automation Meets Demand Generation
Alina Tatevosyan | Partner Marketing Manager

Learn how Demandforce integrates with Dentrix to make marketing your practice easy and effortless.

W

e at Demandforce appreciate your expertise in
dentistry and respect your profession by helping
you manage several key aspects of your business,
such as your online reputation, email marketing, and patient
satisfaction. You already use Dentrix to create a digital dental
practice, but how are you using other technology to get more
patients in the door? Do you feel left behind in the wake of
rapid growth in the Internet economy and community? Perhaps
you’ve become deterred from learning the ins and outs of email
marketing because it seems so exhausting, foreign, or obtuse.
Demandforce, a Dentrix Connected Partner, works with your
Dentrix software to help you create a seamless integration.
Email marketing is a necessary component to a successful
marketing strategy, but just as important are the message and
the audience. At Demandforce, we focus on providing the tools

Figure 2 Schedule delivery of your message.

Figure 1 Customize your message to meet your needs.
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to deliver the right message, to the right patient, at the right
time. For example, the campaign module allows Demandforce
users to segment their entire patient base to send a communication that will deliver the maximum results based on criteria you
select. Take a look at how easy it is to generate awareness on
services and increase production in just a few steps.
First, select your message. Demandforce has templates
available, but you can always design your own campaign or
even upload an HTML file. Next, customize your message with
a special offer, unique images, expiration date, or anything
else you would like to include (Figure 1). Preview your message
to ensure that everything looks just right. In fact, you can send
a test email to yourself or someone on your team to ensure
that there are no broken links or other errors.
Now comes the fun part—select the recipients you want to
receive the email. Demandforce allows you to select patients to

receive a specific communication using criteria you set. You can
use age, gender, visit history, patients’ insurance type, procedures received during a given time period, provider codes, star
rating a patient has given in a review, and more to segment your
entire patient base.
Lastly, refine your list and schedule delivery (Figure 2). You
can send the email right away or postpone it until you are ready.
In either case, you are in control of who receives your message
and when. All email messages are customizable and actionable,
allowing patients an opportunity to request an appointment or
update preferences right from the email 24/7.
In addition to email marketing, Demandforce automates dayto-day tasks, such as appointment reminders and confirmations,
based on your patients’ preference for email or text messaging.
Online communication makes it easier to interact with your
patients and frees up staff time to focus on patients who are
in the office. When a patient uses email or text messaging
to confirm an appointment, the confirmation is automatically
recorded in your Dentrix software, eliminating another administrative step for staff (Figure 3).

appointment with an auto shop around the corner, or even a
veterinary office where your prospective patient takes his or her
pet. Anytime someone confirms an appointment with another
Demandforce business, your contact information comes up as a
recommended dentist for the area (Figure 4). Your Demandforce

Figure 4 The Demandforce Network profile page.
Network profile page is complete with your certifications and
affiliations, contact information, business hours, Demandforce
reviews, and allows prospective patients to request an appointment right on the spot. Keep in mind, these consumers are
already visiting other Demandforce businesses, so not only are
they familiar with the technology, they are spending disposable
income. It’s easy, it’s simple, and best of all, it’s automatic!

Figure 3 A Demandforce confirmation in the Dentrix
Appointment Book.
Demandforce not only gives you a modern communications tool that connects you directly and immediately to your
current patients, it also connects you with other successful,
local, non-competing businesses, giving you greater exposure
to new patients through the Demandforce Network. Here’s
how it works. When patients confirm an appointment with your
practice, the confirmation is recorded in your Dentrix software.
Your patients also see a “Thank You” web page where they
can add the appointment to their calendar, look up directions
to the office, and access your complete practice information.
In addition, Demandforce highlights other non-competing
businesses in your area. Now you might be wondering how this
Demandforce Network benefits your practice. While your patient
confirms an appointment with your office, a chiropractic patient
is doing the same with a Demandforce chiropractor down the
street. Someone else in your neighborhood is confirming an

We focus on providing the tools to
deliver the right message, to the
right patient, at the right time.

As the dental industry continues to modernize, it is increasingly important that your practice has the tools to stay top of
mind with your current patients and gain visibility with prospective patients. Demandforce helps your practice reach its goals
and gives you the opportunity to spend less time worrying about
growth and retention and more time doing what you do best—
practice dentistry.

The businesses listed here are not owned or controlled by Dentrix or Henry Schein and have created these descriptions of their company,
products and services themselves. Dentrix and Henry Schein make no independent assessment of the above descriptions and consumers
should contact these providers directly if seeking additional information about their products or services.
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D entri x b y th e N um be r s
2012 Dentrix Workshops
Dentrix workshops are small, focused classes that offer a hands-on learning experience to help you get the most
out of your Dentrix software. In 2012, Henry Schein Practice Solutions hosted over 160 workshops in cities across
the United States. 2,340 people attended a workshop last year and earned almost 17,000 hours of CE credit.

Who Attends Dentrix Workshops

How Much Dentrix Experience Attendees Have
Dentist

Front
Office

11

.1%

3%

.

28

5+ years

1-2 years

27.2%

14

3-4 years

.9
%

Dental
Assistant

Office
Manager

9.5%

%

9.1

Other
Hygienist

Where Workshops Were Held

Register Today
Visit www.dentrix.com/workshops to view a schedule of upcoming workshops, including our new Treatment Planning &
Case Presentation workshop, and to register for a class.
34 | www.Dentrix.com/Magazine

Put More of Dentrix
to Work for You.
Find out how at a Dentrix Workshop!
Ever wonder if you’re doing things the hard way? Many Dentrix users
have only scratched the surface of what Dentrix can do for them.
Come to a hands-on workshop to gain an in-depth understanding of
how Dentrix works, so you can get the full benefit of many Dentrix
tools that will make your work easier, learn tips and tricks to streamline
your daily routines, and become more productive and profitable!

Dentrix Workshops Coming to 42 Cities Nationwide!

Insurance: Billing and
Collections Workshop

6

Do It Right to Get Paid Faster

CE CREDITS*

6

Continuing Care
Management Workshop

CE CREDITS*

Optimize Your Continuing Care System

Gain an in-depth understanding of how to correctly bill
insurance in order to increase claim acceptance and collect
more quickly and easily.

Improve patient care, retention and revenue by gaining an
in-depth understanding of how to set up and maintain an
effective continuing care system.

$299 per
person

$299 per
person

1-day class for experienced Dentrix users
9 a.m. – 5 p.m.

Going Paperless Workshop
Make a Plan to Go Paperless

6

CE CREDITS*

NE
O
and Cas

1-day class for experienced Dentrix users
9 a.m. – 5 p.m.

SE! Treatment Planning
esentation Workshop

Create & Present Treatment Options Effectively

6

CE CREDITS*

Learn to use Dentrix tools instead of paper in your frontoffice routines to streamline workflow, save money and
increase efficiency.

Learn in-depth how to
ate, customize, present and manage
patient treatment plans f improved patient education, case
acceptance and documentation.

$299 per
person

$299 per
person

1-day class for experienced Dentrix users
9 a.m. – 5 p.m.

Essent als Workshop
M

the Basics

12

CE CREDITS*

Become familiar with the essenti l Dentrix features that will help
you work more effectively in yo r pr ctice, and make your daily
routines easier and more efficient.

$449 per
person

1-day c
for experienced Dentrix users
9 a.m. – 5 p.m.

$40 OFF
PER SE AT

E A R LY R E G I S T R AT I O N
S AV I N G S!
W H E N Y O U R E G I S T E R AT
L E A S T 3 W E E K S E A R LY

Earn up to 12 CE Credits

2-day class for newer Dentrix users 9
a.m. – 5 p.m.

View Complete Course Information and Register Online at

w w w.De nt ri x .co m / Wo r k s ho p s
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Henry Schein Practice Solutions
727 E. Utah Valley Dr.
American Fork, Utah 84003

